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Introduction 

 

Dear Valued Customer, 

Thank you for purchasing the Revolutionary Science RS-IC-100 IncuCount. We are 
confident that when used correctly, our IncuCount will provide years of reliable   
service. We have made every effort to use high quality, durable parts to deliver the 
performance expected of instruments costing 2 to 3 times as much. 

You may enjoy visiting our web site at www.revsci.com.  Please let us know what you 
think of our products, positive or negative, so we can continue to enhance and     
improve our products in the future. 

 

 

Sincerely yours, 

 

REVOLUTIONARY SCIENCE 

 

 

 

 

 

 

 

 

 

 

 

NOTE: This manual contains important information, safeguards and operating     
instructions for the operation of the REVOLUTIONARY SCIENCE model RS-IC-100 
IncuCount by Alternative Pioneering Research & Development, Inc. (APR&D, Inc.) 
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Parts Checklist 

 

   Part      Model number 

_ IncuCount     200-A00001 

_ Carrying case     100-A00002 

_ Light aperture     200-A00003 

_ Petri dish holder 

_ Software (1 CD ROM)    100-A00004 

_ Manual      310-A00001 

_ Detachable power supply     

 

Notes & Service Record 

 

For your own future reference and to expedite answers to your questions, please 
complete the following information: 

Date Purchased _________________________________________ 

Serial Number __________________________________________ 

Model Number __________________________________________ 

Purchased From _________________________________________ 

Your Notes: 
_______________________________________________________________
_______________________________________________________________
_______________________________________________________________
_______________________________________________________________
_______________________________________________________________
_______________________________________________________________
_______________________________________________________________
_______________________________________________________________
_______________________________________________________________
_______________________________________________________________
_______________________________________________________________ 
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Warranty 
 

Warranty Registration 
Please fill out this page, or a copy of it, and send it to the address below to validate 
your warranty. Warranty Registration Card for the REVOLUTIONARY SCIENCE  RS
-IC-100 IncuCount. (Please Print) 

Date Purchased: ___________ Serial Number:__________________ 

Purchased From: _________________________________________ 

(Please check one) ____ Company ____ School ____ Individual 

Name of Department or Institution: 
_______________________________________________________________
__________________________________________ 

Address: 
_______________________________________________________________
_______________________________________________________________
______________________ 

Intended use: 
_______________________________________________________________ 

Where did you hear of our product? 
_______________________________________________________________
_______________________________________________________________ 

Comments: 
_______________________________________________________________
_______________________________________________________________
_______________________________________________________________ 

 

Warranty Policy 
Your REVOLUTIONARY SCIENCE RS-IC-100 IncuCount is warranted to be free 
from defects of material or workmanship under normal use for a period of two 
years from date of purchase.  If your RS-IC-100 IncuCount proves to be defective 
within this warranty period, APR&D, Inc. will repair or replace your unit at our    
option.  This warranty will be void if malfunction is caused by accident, misuse, or  
negligence, including tampering, abuse, or damage in transit.  This warranty excludes 
any relief for incidental or consequential damages. 
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Safeguards & Cautions 

 
To maximize the use of the IncuCount, please follow the                         
recommendations in this short list before using: 

1. Examine carton and contents for possible damage to the product caused   
during shipping. If damage is present contact carrier at once.  Failure to do so 
immediately may release the carrier from any liability of damage. 

2. Fill out the checklist (page of instruction manual).  If something is missing 
please contact us. 

3. Carefully read this instruction manual before operating the IncuCount. 

4. Fill out warranty registration card and mail it to APR&D, Inc. 

 

Limitations of Use 

 

*Revolutionary Science is not responsible for misuse of the IncuCount 100 

1. ALWAYS pre-clean the IncuCount light panel of residue after use with a damp 
cloth and appropriate mild detergent solution.  Never clean IncuCount with  
organic solvents like thinner or benzene.  It will damage the surfaces. 

CAUTION: This is the only recommended method of cleaning. 

2. Never attempt to dismantle or modify the IncuCount.   

3. Never operate the IncuCount with a damaged USB cord or after the appliance 
malfunctions or has been damaged in any manner.  THIS MAY CAUSE DAMAGE 
TO YOUR COMPUTER. 

4. Accessory attachments not recommended by Revolutionary Science may  
damage to the IncuCount or the computer. 

5. Never place the IncuCount or any part of the IncuCount in an environment 
that exceeds 65 degrees Celsius or below 5 degrees Celsius.  Humidity should be 
at or below 65%. 

6. Never use IncuCount for any purpose other than the intended use. 
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7. When used at high temperatures, the IncuCount may be  uncomfortable to 
the touch.  When removing the IncuCount from the incubator, it is               
recommended to use temperature resistant gloves or turn off the incubator and 
allow the IncuCount to cool to a comfortable temperature before removing it. 

8. Never attempt to modify the plugs or cords.  This may cause damage to the 
IncuCount or your computer. 

9. Never immerse the IncuCount, cord, or plug in water or operate on wet  
surfaces. 

10. Never allow the cords to contact hot surfaces beyond 65°C.  Any slack in 
the cord should be wrapped up and held together with a band. 
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Intended Use 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Revolutionary Science IncuCount 100 can be used for the following 
purposes: 

 

1. Colony Counting: 

• Count colonies on Petri dishes 

2. Measure the inhibition zones of antibiotic samples 

• Monitor the inhibition zones in an incubated or refrigerated environment. 

3. Monitor inside an incubated environment 

• Count colonies as they grow in real time 

• Measure inhibition zones as anti-biotic reactions occur in real time 

4. Animate 

• Create an animation of any Petri dish reaction, such as colony growth or 
inhibition zones.   

IncuCount RS-IC-100 
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Specifications 

 
Model No.:    RS-IC-100 
Power requirements:   100 -240 VAC 60 HZ 1.5 amps 
Net weight:    5 lb. (shipping weight 6 lb.) 
Dimensions:    7.25 inches tall x 6.25 inches diameter 
Lights:    High intensity LED lights, top and bottom 
Camera:    16 megapixel digital camera 
Computer interface:  USB 
Petri dish size capacity:  Up to 100 mm in size, including 3M Petri Film 
CE/UL Certifications:  UL approved LED lights and power supply 
 
System Requirements 
Hardware:   Computer, CD ROM, USB interface 
Memory:    Min 512MB, 500mhz 
Operating System:   Windows XP, or higher 
Hard drive space:   Min 150MB 
Warranty:    2 year, repair or replacement 
 

Contact Information 

 

Revolutionary Science 

17319 Lake Blvd 

Shafer, Minnesota 55074, USA 

Customer Service:  1(800) 775-7942 

Technical Assistance:  (651) 674-3112 

Fax:   (775) 218-7015 

Web site: www.revsci.com     E-mail: support@revsci.com 
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Hardware Installation 
 
Note: Hardware MUST BE INSTALLED before software is installed. 

1. Place IncuCount on a dry, level surface, note: whether inside or outside an 
incubated or refrigerated environment it does not matter. 

2. Plug USB cord into a nearby computer. 
 
 
 
 
 
 
 
 
 

 
3. Plug the power adapter into the wall outlet (100 to 240VAC) 
 
 
 
 
 
 
 
 
 

 
4. Insert the barrel connector to the power socket at the rear of the unit. 
 
 
 
 
 
 
 
 
 

 
5. If the IncuCount is placed inside an incubator or refrigerator, the door can 

shut on the USB cord and power cord as long as it does not damage 
them. 

 
Note: Software will install, but will not open if the IncuCount is not hooked up 
properly. 

Illustration 1: USB Cord 

Illustration 2: Power Adapter 

Illustration 3: Barrel Connector 
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Software Installation 
 
Note: Hardware MUST BE CONNECTED before software is to be   
installed.  Please also note: after software installation you will be 
prompted to restart your computer to complete the process. 

1. Insert IncuCount installation CD ROM in the computer.  The following 
window should show up on your screen.  If the window does not show, 
click on the IncuCount Installer Icon.  Click 'NEXT.' 

 
 
 
 
 
 
 
 
 
 
 

 
2. Choose a destination folder and click 'INSTALL.’ 
 
 
 
 
 
 
 
 
 
 

 
3. Installation software will then copy all necessary files to your  computer.  

The installation software will alert you when it is complete.  The driver 
setup program will then run to install the IncuCount camera driver.  If 
the IncuCount camera is not yet connected to a designated USB port, do 
so now. 

 
 

Illustration 4: Setup Options 

Illustration 5: Choose Instillation Folder 

Illustration 6: Camera Driver Setup 
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4. Select language. Click ‘OK.’ 
 
 
 
 
 
 
 
 
 
 
5. Click ‘INSTALL.’ 
 
 
 
 
 
 
 
 
 
 
 
6. When the driver setup is complete, you will be prompted to reset your 

computer. 
 
 
 
 
 
 
 
 
 
 
 
 
If you have difficulty installing the software or connecting the hardware, 

please contact Revolutionary Science Technical Support. 
Note: There is no charge for contacting Technical Support. 

Illustration 7: Choose a Language 

Illustration 8: Installing Camera 

Illustration 9: Restart Computer 
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Setup – Lighting, Focusing, Brightness and Contrast Controls 
 
Light Control 
The IncuCount comes equipped with an upper and a lower bank of LED lights.  To 
turn on/off these lights, flip ‘ON/OFF’ the rocker switches located in the back of 
the unit (see Illustration 10).  (As viewed from the back, camera end up) the left 
switch controls the lower bank of lights and the right switch operates the upper 
bank. 
 
 
 
 
 
 
 
 
 
 
 
 
To test the lights, run the IncuCount software and click the ‘LIVEFEED’ button 
(see Illustration 11) in the gray control panel (also located in the View menu under 
Live Video Feed).  The lights should activate (depending on which rocker switch is 
on).  Adjust according to preference and agar color (See Illustration 12). 

R E V O L U T I O N A R Y  S C I E N C E  

Illustration 10: Switches for Top and Bottom Lights 

Illustration 11: Live Feed Button 

Illustration 12: Blood Agar Plate with Bottom Light On 
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Light Aperture 
Place the light aperture (black ring, Illustration 13) into the unit on the light box. 
Note: The purpose of this important mechanism is two fold. 

Centers the Petri dish in the camera's field of view 
Blocks out excess light around the Petri dish, providing the best possible view 

of the sample. 
 
 
 
 
 
 
 

Focusing 
Run the IncuCount software and open up 
the live video feed by clicking on the Live-
Feed button (see Illustration 11, page 12).  
Open the camera control panel by          
left-clicking on Video Setup in the Tools 
menu.  While viewing the live video feed, 
position a Petri dish inside the black aper-
ture (see Illustration 12, page 12).  Move 
the focus slider to the right or left until 
Petri dish is in focus.  Because of different 
agar depths, this may need to be done, but 
rarely.  Close Live Video Feed window 
when the Petri plate is in focus.  Change 
the Exposure and Gain sliders to achieve 
the desired brightness.  Turn on Auto 
Controls if desired for auto focus and auto 
exposure. 
 
 
 
 
 
Brightness and Contrast Controls 
To change brightness or contrast bring up the webcam properties page and left 
click of the Advanced Settings Tab (see Illustration 14).   Move the Exposure, Gain, 
Brightness, Contrast and Color Intensity sliders to the right or left to get the best 
picture.  (See Appendix B for an explanation on the camera controls) 

Illustration 13: Light Aperture 

Illustration 14: Camera Settings 
to Adjust Focus, Exposure, etc. 
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Creating a New Project 
 
1.To create a new project, click on ’NEW PROJECT’ (see Illustration 15) in the file 
menu. 

 
 
 
 
 
 
 
2.A file dialog box will pop up (see Illustration 16) asking you to create a new 
folder for the project.  This will be the folder where captured images are stored as 
well as data files.  Type in a meaningful title for the folder and click ‘OPEN.'  You 
are now ready to start capturing images. 
 
 
 
 
 
 
 
 
Capturing Images 
 
To capture an image for counting or measuring an inhibition zone, click the     
’CAPTURE’ button in the gray control panel (the control panel will look like    
Illustration 18 or 19, depending on whether the Colony or the Antibiotic button is    
selected).  If you haven't yet created a new project, you will now be prompted to 
do so (see Creating a New Project section on this page). 
 
 
 
 
 
 
 
 
 

The lights on the IncuCount should flash (see Setup section, page 9) and the  image 
of the Petri dish inside the IncuCount should appear on the screen.  Before count-
ing, you may need to adjust the sensitivity.  Before capturing, you may need to 
adjust the focus and lighting. 

R E V O L U T I O N A R Y  S C I E N C E  

Illustration 15: Creating a New Project 

Illustration 16: Create Project Folder 

Illustration 18: Capture-Inhibition Zones Illustration 17: Capture-Counted Colonies 
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Colony Counting 
 
To count an image, simply click the ‘COUNT’ button on the control panel.  The   
Colony-Forming Unit (CFU) count will appear in the Type C text field (see      
Illustration 19).  Dark regions judged too small (see Sensitivity and Size section on 
page 17) will appear in the Invalid text field.  If you are counting more than a single 
type of bacterium (see Counting Multiple Colony Types, this page), the CFU count 
of each will appear in the Type A, Type B, or Type C text field. 
 
 
 
 
 
 
 
 
 
 
In the Image Panel, colonies will be colored green, while those too small (see   
Sensitivity and Size section on page 17) appear as red (see Illustration 20). 
 
 
 
 
 
 
 
 

Illustration 19: Colonies of Type C and 
Invalid Appear in Corresponding Text Fields 

Illustration 20: Counted Colonies Appear in 
Green, Uncounted (too small) Appear in Red 
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Counting Multiple Colony Types 
To count multiple colony types, open the Advanced Image View by clicking on the 
‘ADVNACED’ button (Illustration 21) in the Control Panel. 
 
 
 
 
 
 
 
 
 
 
The Advanced Image View panel (Illustration 22) will open up.  You can choose 
the color of your colonies by selecting Type A through  Type J, then left clicking 
again on a representative colony.  This color will show in color box next to ‘Select 
Bacteria Color:’.  Color is represented by 3 numbers (one each for red, green and 
blue, see explanation of color space in Appendix A, page 29) ranging from 0 to 
255.  You can change the tolerance (measure of how close a color is to your rep-
resentative color) by typing in a number between 0 and 255. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Alternatively, you can set the Agar color by clicking the ‘AGAR SELECT’ button 
(see Illustration 23).  This will allow you to choose which color will not be 
counted. 

R E V O L U T I O N A R Y  S C I E N C E  

Illustration 21: Click on Advanced Button to 
Open Advanced Image Window 

Illustration 22: Advanced Image View Panel 

Illustration 23: Select Agar Color 
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Sensitivity and Size 
Counting is performed by scanning for dark regions on the image of the Petri 
plate. 
You can set the minimum size of a counted CFU (measured in pixels).  Counted 
CFUs show up green while uncounted ones show up red.  Adjust the Minimum 
Size slider to give you the best count. 
 
 
 
 
You can adjust the sensitivity (measure of how dark a  
region needs to be in order to be counted) by either  
typing in a value between 0-255 in the sensitivity field  
or moving the sensitivity slider.  Adjust the slider to  
give you the best count. 
 
 
Centering Countable Area 
While adjusting the size and sensitivity, you may have noticed a red circle drawn 
around the inside of the image of the Petri dish.  Dark regions inside this circle will 
be counted, while dark regions outside of the circle will not be counted.  To 
change the radius or position of this circle, click Center in the 
Tools menu. 
 
 
 
 
 
 
To change position of the counting area (see Illustration 27), position the mouse 
where the new center should be and left click on the mouse.  To change the   
radius (see Illustration 28), position the mouse on the outer edge of the counted 
area and right click on the mouse. If a spiral plate is being counted, left-clicking 
while holding down the 'Shift' key will make a concentric circle appear (see      
Illustration 29) on screen.  The area within this circle will not be counted.  Holding 
down the 'Shift' key and right clicking the mouse will remove this circle. 
 
 
 
 
 
 

Illustration 24: Minimum Size Slider 

Illustration 25: Sensitivity Slider 

Illustration 26: Center Tool 

Illustration 27: Center the  
Counting Area 

Illustration 28: Resizing the 
Counting Area 

Illustration 29: Concentric 
Circle for Spiral Plate  

Counting 
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Sequential Imaging 
 
Colony counting is the default mode.  In the gray panel to the right (see software 
image below), are controls for Sequential Imaging and Colony Counting use.    
Sequential Imaging means capturing and counting Petri plate images at set intervals 
for a specified time. 

To set times, enter the time that the IncuCount should begin capturing images 
into the Start Time field.  All time is measured on a 24hr/day clock, (for 
example, 13:23:59 would be 1pm, 23 minutes, and 59 seconds). 

Enter starting date in the Start Date field.  All dates must be in the format 
“MM/DD/YYYY”.  Incorrect formatting will result in the data field being 
replaced with the current day in the correct format. 

Set the Stop Time and date just as you did the Start Time and date.  Enter in 
the interval time (time between image captures) into Interval time field. 
Interval time is recorded in minutes (default is 20 minutes). 

Press the ‘START’ button to start automatic capture.  If any field is left blank 
or has an incorrect format, it will be corrected to the current time/date 
(or a day later for the stop time/date). 

If you haven't created a new project you will be prompted to do so now (see     
Creating a New Project, page 14).  Images will then be captured (see Illustration 
30) and counted at the appropriate times.  Information about the current image is 
shown in the center text column.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Growing Bacteria Upside Down 
It is recommended that most Petri plates inoculated with bacteria be grown upside 
down.  This can be done by using the retaining clip (included) to hold the Petri dish 
in place and then simply turn the IncuCount upside down.  The software will adapt 
to the repositioning of the IncuCount. 

R E V O L U T I O N A R Y  S C I E N C E  

Illustration 30: Captured Image. 
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Advanced Features 
 
Advanced Image View 
To access advanced features of the IncuCount, open up the Advanced Image View 
window by clicking on the Advanced button in the control panel (see Illustration 
20, page 15).  In addition to being able to select agar and colony color, the       
Advanced Image View panel has 5 other buttons: Make Movie, Preview Movie, 
Reset Image, Zoom, and Video Feed (see Illustration 32). 
 
 
 
 
Make Movie (animate) 
Click on the ‘MAKE MOVIE’ button, you will be prompted to name your movie.  
Movies may be created in .mov format only.  Type in an appropriate name for your 
movie and click save. 
A window will request the frames per second (fps) of the animation (see I       
Illustration 32).  Enter in an appropriate value and click on ‘OK.’  Movies may be 
viewed in an appropriate media viewer.  Movies may also be viewed by clicking the 
‘PREVIEW MOVIE’ button. 
 
 
 
 
 
 
 
 
Previewing a Movie 
If you want to watch a movie of your Petri dish images, click on the ‘PREVIEW 
MOVIE’ button in the Advanced Image View window.  You then will be asked how 
fast you want the movie to be played.  Enter the speed and press ‘ENTER’ or click 
‘OK.’  Your movie will be shown in the Advanced View's image panel. 
Reset Image 
After previewing a movie or zooming, you may have to reset the image on the 
Advanced Image View.  Press the ‘RESET IMAGE’ button.  This will reset the image 
shown in the image panel to the current image shown in the main panel. 

Illustration 31: Advanced Image View Buttons 

Illustration 32: Enter Movie Speed 
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Zoom 
To zoom in on a feature in the Advanced Image View's image panel, click the 
‘ZOOM’ button then make a box around the feature (see Illustration 33) by mov-
ing the mouse and left clicking where you want the corners of the box to lie. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To close up the box, right click where you want the final corner to lie.  A    blown
-up image of your boxed in region will appear in the image panel (see Illustration 
34). 

R E V O L U T I O N A R Y  S C I E N C E  

Illustration 33: Advanced Image Zoom 

Illustration 34: Zoomed in Image 
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Live Video Feed 
Click the ‘VIDEO FEED’ button to open the Live Video Feed panel.  This panel is 
used for focusing the camera (see Focusing, page 13).  Close this panel when com-
pleted, else it may interfere with image capture. 
 
Selecting a Previous Image 
 
After capturing  2 or more images, select which image is currently shown in the 
image panel by clicking on the icon of your image in the image chooser panel.  This 
icon will highlighted with a red box and the image will appear in the image panel.  
The CFU count will appear above the image along with the image's name. 

 
 
 
 
 
 

 
Making Notes 
 
Notes can be made about any image by clicking in the Notes field (see Illustration 
36) and typing whatever notes need to be made.  These notes are associated with 
the currently selected image. 
 
In the image chooser panel, the note will be indicated above the icon of its      
associated image. 
 
 
 
 
 
Saving a Project 
 
Once the project is complete (or any time during), the project may be saved by 
clicking on ‘SAVE’ in the File menu.  This will save the project data file in the image 
folder created previously. 

Illustration 35: Selecting a Previous Image 

Illustration 36: Making Notes 

Illustration 37: Saving a Project 
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Opening a Saved Project 
 
To open a previously saved project file, click on ‘OPEN PROJECT’ (Illustration 38) 
in the File menu. 
 
 
 
 
 
 
 
 
 
You will then be asked what file you want to open.  Highlight the .dat file (see  
Illustration 39) and click ‘OPEN.’ 
Your project will then load. 
 
 
 
 
 
 
 
 
 
 
 
Importing Images 
 
Images may be imported into a project by clicking on Import Image (see          
Illustration 40) in the File Menu or Add Frame from the gray control panel.  A 
window will open up with the caption, “Importing Image:” (Illustration 41).  Type 
in the name of the desired image file.  Click ‘OPEN’ and the image will show up on 
the image panel. 

R E V O L U T I O N A R Y  S C I E N C E  

Illustration 38: Opening a Project 

Illustration 39: Selecting a Project to Open 

Illustration 41: Select Image to be Imported into Project 
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Illustration 42: Export to Spreadsheet 

Illustration 43: Tools Menu 
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R E V O L U T I O N A R Y  S C I E N C E  

Illustration 44: Creating an Exclusion Zone 
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Email Setup 
When Email Setup is selected from the Tools menu, a setup dialog (see Illustration 
45) is loaded where information necessary to sending an email is stored.  Email 
Setup requires an Outgoing Server (smtp server), Port number, User Name and 
Password, and a List of Recipients (separated by a comma): 

Outgoing Server: This is the address of outgoing server 
(for example smtp.gmail.com , for a gmail account), 
refer to mail server's literature for more information 
on configuring a smtp client. 

Port-enter port number: (refer to mail server's        
literature). 

User Name and Password: This is the user's email    
address or login name (refer to mail server's literature) 
and associated password. 

List of Recipients: Type in the full address of each      
recipient of email messages separated by a comma. 

 
 
Selecting the Test button will send a user selected file to each of the recipients to 
verify the information in the email setup is correct.  Select the 'APPLY’ button to 
save the setup information or exit to cancel.  (Selecting the Test button will also 
save setup data) 
Video Setup 
To change default video settings, left click ‘VIDEO SETUP’ in the tool bar.  This 
brings up the camera properties page.  Adjust these settings for best picture qual-
ity (See Focusing, page13, Brightness, Contrast, Color Controls, page 13 and Ap-
pendix B, page 30) 
 
 

Illustration 45: Email Setup 
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Antibiotic Reactions, Measurement of Inhibition Zones 
 
To measure inhibition zones (see Illustration 46) of an       
antibiotic reaction, click ‘ANTIBIOGRAM’ in the Tools 
menu or click ’ANTIBIOTIC’ in the Control Panel.  The   
control panel will display controls suitable to antibiotic 
use (see Illustration 49).  To get back to colony counting, 
click on ’COLONY’ in the Control Panel or deselect      
‘ANTIBIOGRAM’ in the Tools Menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 

R E V O L U T I O N A R Y  S C I E N C E  

Illustration 46: Click Antibiotic to 
get the Antibiotic Controls Up 

Illustration 47: Measuring Inhibition Zones 
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Finding Inhibition Zones 
To find zones of inhibition, click on the ’FIND’ button in the control panel. 
 
 
 
 
 
 
This will locate all antibiotic discs and will simultaneously determine the diameter 
of inhibition zones.  Measurements are calculated assuming an 86mm (inner     
diameter of a 90mm plate) total width.  The diameter of the disc is included in this 
measurement. 
If, in some cases where visibility is poor, due to agar color or unusual growth  
patterns, the program may fail to find the correct measurement.  In these cases, a 
manual adjustment to the measurement is recommended.  This can be done by 
right-clicking and dragging the mouse, releasing the mouse once you have reached 
the outside of the inhibition zone.  A blue circle (see Illustration 49) will appear 
once you start dragging the mouse, indicating the new size of the inhibition zone, 
should you release the mouse button. 

Illustration 48: Click the Find Button to 
Measure Inhibition Zones 

Illustration 49: Resizing Inhibition Zones 




